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Getting Started 
 
 
Setups 
 
Before using LightSpeed and its powerful features, there are several settings that must 
first be configured, including information about your Company, your region’s taxes, and 
the users who will be using the software.  These are found in the Tools menu, under the 
Setup option.   
 
While LightSpeed has many more features than those listed here, these are the basic 
requirements for you to get started with the software.  For details on these and other 
features, please see the Setups chapter in the LightSpeed manual.  
 
 
1. Create your Company.           
>Tools/Setup/Company 
 
Company, Addresses and Contact Info, Fine Print Sections 
To start, enter your Company name, along with your Billing and Shipping Addresses, 
Phone Numbers, Email Addresses, and Web Site Addresses in the available fields. The 
Fine Print section allows you to enter the fine print that prints at the bottom of Quotes, 
SRO’s and Invoices. 
 
Logo 
LightSpeed can store a 192 x 192 pixel JPEG logo for your Company. Drag a JPEG file 
to the Logo section, and the image will be scaled and saved to the database. This logo 
will show up on all your printed sales documents.  To remove the logo, click the ‘X’ 
button.   
 
Master Password 
All LightSpeed databases come with a default password set internally that Xsilva can 
use in the instance that you require backend database support. You can change your 
Master Password from the default for maximum security and use the ‘Reset to Default’ 
button to reset it back to the default password when backend database support is 
required. Store this password in a secure place, as it is absolutely irretrievable once 
forgotten.   
 
2. Set up your User Privileges.           
>Tools/Setup/Privileges 
 
The Privileges Setup panel allows an Administrator to determine which groups of Users 
can access which privileges in LightSpeed. Click a Privilege Group to display the 
associated privileges. By default, LightSpeed has three Privilege Groups: 
‘Administrator’, ‘Manager’ and ‘Salesperson’. These can be modified so that their 
Privilege set suits the business’s requirements and can be duplicated to create 
variations on their Privilege set.  
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Click on an Access setting to select a new Access setting from a popup menu. Each 
Privilege within a Privilege Group can have one of five Access settings: 
 

Allowed: User has access to this Privilege 
Not Allowed: User does not have access to this Privilege  
User Authentication: User must confirm their Username and Password to access 
this Privilege 
Mgr/Admin Authentication: User must have a Manager or Administrator enter 
their Username and Password to grant access to this Privilege 
Admin Authentication: User must have an Administrator enter their Username 
and Password to grant access to this Privilege 

 
3. Create your Users.           
>Tools/Setup/Users 
 
Administrators should enter all Users that need access to the system in the Users Setup 
panel. When creating a new User, you can enter their First Name, Last Name and 
Phone Number, and the Login Username and Password that they will log in with. The 
Login Username and Password are case-sensitive. 
 
The Userlevel popup menu allows you to set which Privilege Group each User belongs 
to and the Current checkbox allows you to determine whether the User is currently 
allowed to log in. 
 
Editing or deleting Users will not remove them from any sales documents that they have 
been associated with. 
 
4. Set the ID Number Sequence for Sales Documents.        
>Tools/Setup/ID Numbers 
 
Administrators can set the starting ID numbers for Quotes, SRO’s, Orders, Invoices, 
POs and Timesheets by selecting the type and entering the ‘Next ID’ number. You 
cannot set the ‘Next ID’ number to lower than the ‘Last ID’ number used. 
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5. Set up your Currencies.          
 >Tools/Setup/Currencies 
 
LightSpeed can handle multiple Currencies, which are set up in the Currency Setup 
panel. The primary Currency used in your business must be set as the Default Currency 
with a Currency rate of ‘1’ and the Currency Rates of all other Currency Rates must be 
set correctly in reference to the Default Currency. 
 
6. Set up your Taxes.           
>Tools/Setup/Taxes 
 
The Taxes Section of the Taxes Setup panel is where an Administrator will enter the 
names of up to five taxes and set their GL Accounts. 
 

 
 
Tax Codes specify which taxes and which rates are charged in a particular jurisdiction 
or circumstance. The default Tax Code is the Tax Code that is used when creating a 
new sales document, and is set in the Station Setup window. You can create additional 
Tax Codes for charging out-of-state taxes. An unlimited number of Tax Codes can be 
created.  
 
Example:  Your store is located in Chicago.  You collect a state tax of 7.5%.  You 
would create a tax called “STATE” in the top left box of the Tax Setup window.  Click 
Save.  In the Tax Codes section, click New, name the Tax Code (IL, for example), and 
enter “7.5” in the box below the STATE tax.  Click Save.   
 
An Administrator can set up special Tax Statuses where particular taxes are exempt. If a 
Customer is entitled to certain tax exemptions, or a Product is exempt from certain 
taxes, one can apply the corresponding Tax Status. 
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Taxes also have the ability to be configured according the local specifications. In the 
column marked (1), you can indicate a maximum dollar value for the tax collected.  In 
(2), the checkbox indicates the tax is compounded on the sum of the subtotal plus the 
taxes. In (3), the checkbox indicates a tax that is Paid and must be assigned a GL 
Account for the export to the accounting package.  Unless you are in a region where 
these special considerations apply, do not use these options.  
 
At the bottom of the main Tax window, there is a checkbox that enables LightSpeed to 
calculate its taxes differently. The “System-Wide Tax Inclusive Selling Prices” is 
designed for regions with particular tax calculation involving a requirement for tax-in 
totals. It is recommended that unless you are in such a region, you do not use this 
option.   
 
7. Define your Cities, States/Provinces, and Countries.           
>Tools/Setup/City (State/Province, Country) 
 
Pre-defined lists of commonly-used Cities, States/Provinces and Countries can be set 
up by an Administrator in these Setup panels. Select arrows on the City, 
State/Province, and Country fields of the Customer window allow Users to select an 
item from these pre-defined lists.  You can add to these lists by clicking “New”, 
entering the name, and clicking Save.  You can also choose the default city by clicking 
the checkbox.   
 
Non-Administrator Users can add to the lists by clicking the “+” icon on the Select 
window in sales documents. A new Customer box will come up and if the city is not in 
the list, the “+” icon can be clicked in the drop down menu to add it.   
 

 
 
 
8. Define your Payment Methods.           
>Tools/Setup/Payment Mathods 
 
LightSpeed allows Administrators to set up fifteen Payment Methods that can be 
selected on the Invoice to record payments from Customers. Payment Methods can be 
assigned a Type that determines whether extra information is collected on the Payment 
screen. For example, a Credit Card Type displays a field where the User can enter the 
Authorization Number of the transaction.  Specifying a Payment Method as Credit Card 
also sets it up to process internally through an authorized internal credit card 
processor.   
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9. Set up your credit card information.           
>Tools/Setup/Credit Card Processing 
 

 
 

This step requires that you contact Xsilva Systems by telephone, at (514) 907-1801, or 
by email, at support@xsilva.com, for instruction on the completion of the Credit Card 
Processing Setup.   
 
 
10. Import and Assign your GL Accounts.           
>Tools/Setup/GL Accounts 
 
Accounting packages like MYOB and Quickbooks assign a unique name or number to 
each of their General Ledger accounts.  The Accounting Export from LightSpeed to 
these accounting software packages requires that you first import these GL Accounts 
into LightSpeed and map their unique names or numbers to corresponding items, such 
as Payment Methods, Taxes, and Products.   
 

1. Export your GL accounts from MYOB or Quickbooks.  
2. Open the GL Accounts setup in the LightSpeed Tools menu and import the 
file you exported using the corresponding button. 
3. Select GL accounts for Accounts Receivable and Accounts Payable in the 
Linking section.   
 
Note: In Quickbooks, you must choose between using account names 
or account numbers.   

 
Below is a list of key data in LightSpeed that require a GL Account to be assigned for 
the Accounting Export, and where they can be found.   
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GL Accounts Setup             Accounts Receivable, Accounts Payable 
Product Window, GL tab   Product Income, Product Inventory/Asset, Product  
                                              Expense/COGS 
Taxes Setup                        each tax collected and (if applicable) paid  
Payment Method Setup     each method of payment 
 
 

11. Set up your Station.           
>Tools/Setup/Station 
 
The window for establishing the settings for the POS screen can be found in the File 
menu, under the menu item Station Setup. This is the window where an administrator 
will choose settings for a particular station’s POS hardware, printing configuration, and 
various defaults for POS screen, including tax configuration, search settings, and 
customer type.   
 

 
 
 
 
Station Name 
This field allows you to set the name for this POS station.  This name appears on 
receipts and can be reported on with LightSpeed’s Reporting tools.  
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Card Swipe 
The Card Swipe setting is a pull-down menu that allows you to choose the supported 
card swipe device for credit card transactions, either “ID Tech”, “ID Tech Omni 3237”, 
or “Magtek”.   
 
Printing 
You have the choice to set your printing format to be standard, letter-sized paper, 
suitable for regular laser printers, or to a receipt printer.  Formatting will automatically 
be adjusted for each size.  Note: If the receipt printer is chosen, it will only be accessed 
when printing Invoices.  All other documents – Quotes, SRO’s, and Orders – will be 
printed on 8.5” x 11” format.    
 
You may also choose to disable the print dialog box when printing.  By entering a 
positive value in the Print Copies field, that number of invoices will be printed with or 
without a dialog box, depending on what is set.  Again, this is only applicable to 
Invoices – a print dialog will appear for other documents.  If the value is set to zero, a 
dialog box will appear for Invoices, as well.   
 
Defaults 
Receipt Printer – Choose your receipt printer here.  
 
Cash Drawer - If you have a cash drawer, indicate how it’s connected using the pop-up 
menu.  
 
Pole Display – if you have a pole display, indicate it here.  
 
Turn Sound Off – This checkbox disables the sounds associated with various functions 
in POS. 
 
Start New POS after Printing - If you have a high volume of invoices, you may wish to 
have LightSpeed automatically create a new invoice when the last one has been 
printed.  To do so, simply check this box. 
 
Default Search – This pull-down menu allows you to set which of the four search criteria 
– UPC, Product Code, Description, or Document ID - to use as the default in the main 
POS window.   
 
Default Customer Type – With this pull-down menu, you can choose the default for the 
Customer type – either walk-in or an existing Customer.  If you do not wish to track 
information on your customers, choosing ‘Walk In” will allow you to accelerate the 
speed with which you can perform a transaction.   
 
Default Tax Code – This pull-down menu allows you to choose the default tax code 
from the list you have already set up in your Taxes Setup window.  However, you can 
still choose another tax code for any particular Invoice regardless of this default setting.   
 
VoIP Service – This pull-down menu allows you to choose which VoIP service you’re 
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using, either webFones PBX or Skype.  
 
From the Station Setup window, click the POS Setup button located at the bottom.  
This takes you to a window that allows you to add your logo to the POS screen, as well 
as configure other settings for POS features.   
 
Logo 
This window allows an administrator, or another user set up with the appropriate 
privileges, to insert a logo that will appear on the POS screen. To display a color version 
of your logo, insert a 230 x 80 dpi jpeg version of your logo on a black background.   
 
 
 

 
 
 
The Basics 
 
Adding Customers 
 
There are 2 ways to add Customers to LightSpeed.  The first is to click the Customer 
button in the toolbar and enter the Customer’s information in each field, including their 
Customer category, their default language and currency, and which sales person is 
assigned to that account.   
 
The other way is to use the Import Customers option of the LightSpeed Import Tools to 
import your tab-delimited text file.  Once you choose your file using the Open File 
button, you simply have to drag and drop each field header in the second column to 
match your data in the first column.  The triangles indicate a drop-down menu that 
allows you to specify further information about a particular field.  Click Import – your 
Customer data will be imported into LightSpeed.   
 
 
Creating Suppliers 
 
Before entering your Products, it is advisable to set up your Supplier information.  
Structured similarly to the Customer window, the Supplier window is accessed through 
the Supplier icon in the toolbar.  Enter the Supplier information, including their contact 
name, the Currency they bill you in, and whether or not this is your default Supplier.  
Note – this is not to be confused with the designation of a default Supplier for each 
Product, which is done in the Product window.  Each Supplier you create will appear in 
the pulldown menu you access to add Suppliers to each Product, as well as being 
included in the list of Suppliers you export in the Accounting Export procedure.  
 
 



GETTING STARTED 

  9 

 
Adding Products  
 
There are 2 ways to add Products to the LightSpeed database.  The first is simply to 
click the “New Product” icon and enter the information manually, including the Product 
Code, the Description, its UPC code, at least one Supplier, the Cost, and the Selling 
Price.  You can also put the Product into your Inventory using the Adjust button in the 
Inventory tab.   
 
The other way is to import a list of Products from a tab-delimited text file using the 
LightSpeed Import Tools included with LightSpeed.  One of the choices in the main 
menu of the Import Tools is Import Products.  Click this button and a window will 
appear with a Preview pane in which you can match up fields and save your settings.   
 

 
 
 
Setting Prices 
 
When your Products are entered in the Products database, you may wish to set their 
selling prices to a fixed price or one calculated from either the default Cost or an 
alternate Cost associated with a particular Pricing Level. This can be done according to 
their Family, Class, or other category by batch rather than individually, in the interest of 
saving time.  To do this, you can choose the Set Selling Prices option of the Tools 
menu.  There, you will be able to select subsets of your Products using a series of filters 
that will allow changes to be applied to only those Products that meet your chosen 
criteria.   
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Once you have the subset you wish to change, you are able to decide if you want to 
simply set the Fixed Price, or to calculate a markup using a percentage or a dollar 
value, or a combination of the two.   
 
In addition, you can also set the Sell Price for the Pricing levels you’ve created in the 
Pricing Level Setup option in the Tools menu, allowing you to customize pricing for 
different categories of your Customers.  You may also specify which Cost on which to 
base this calculation; the standard Cost or a Cost particular to a certain Pricing Level. 
To do this, use the pull-down menu that allows you to “Set Price for” to select the 
Pricing Level, and using the adjacent pull-down menu, select the Cost you wish to use 
– the standard Cost for the Product, or one associated with a particular Pricing Level.  
 
You may use the Rules button to save any of these criterion/action combinations for the 
creation of future Products.  
 
 
Quoting 
 
First, you assign a Customer name to the Quote.  If you do not want to add the 
Customer to the database, you can specify them as a Walk-In, and then you may 
include as much or as little identifying information as you like.  If the Customer already 
exists in the database, type a few letters of their name, or their telephone number in the 
search bar, or click All, and choose their name from the resulting list.  If it is a new 
Customer, click the “+” icon, enter their information in the Customer window that 
appears, and click Save.  When asked if you would like to reload the Customer 
information in the document, click OK.   
 
To add Product to a Quote, you can either scan its UPC, type a few letters of its 
description or Product Code, or click All, and choose it from the resulting list.  You are 
able to modify the Quantity, and, if the Product is set up to accommodate it, you are 
also able to modify the Sell Price.  When you have completed the Quote, click Save.  
Once saved, you are able to then do one of two things to the Quote - create an Order 
using the Order button to request the Product be reserved or ordered on a PO, or, if 
some or all of the Products are in stock, create an Invoice using the Invoice button, 
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which will transfer ALL the Product on the Quote to an Invoice.  You can then remove 
any Product the Customer won’t be purchasing.   
 
 
Ordering  
 
Stock Order or Customer Order 
To place a stock order, choosing the New Stock Order option from the File menu allows 
you to request Product for your Inventory.  A new Order will appear with your company 
information populated as the Customer. To make a Customer Order, click the Order 
button in the task bar.  A Customer Order looks identical to a Stock Order, except that 
you choose the Customer in the Customer section.   
 
Next, enter the Product you want, taking note of the quantities in the Inventory status 
bar.  You can cycle through these statuses by clicking the arrow icon.  Click Save. If 
there is Product available for the Order, you may reserve it by clicking the arrow icon in 
the Order Inventory status bar, and choosing the appropriate option (see chapter on 
Quotes, Orders, Invoices for more details).   
 
If you decide to create a PO solely from this Order, click the PO button and choose 
your Supplier from the Suppliers you have created.  In the case that you would like to 
sort and aggregate your Orders in a given time period into PO’s according to default 
Supplier, see Purchasing (below). 
 
Product can also be ordered directly from sales documents (ie. Quotes, SRO’s, and 
Invoices) using the Order button.  On Quotes and SRO’s, the Order button will transfer 
all Products to an Unsaved Order.  On an Invoice, the Order button is used when there 
are Products being backordered, and only those Products with quantities in the 
Backorder column will be placed on an Unsaved Order when the Order button is used.   
 
 
Purchasing  
 
To view your Purchasing documents – Orders, PO’s, and Supplier Invoices – click the 
Purchasing Browser icon located at the right side of the toolbar.   
 
In the Requests tab of the Purchasing browser, you are able to view Product requests 
from Orders on a line-item basis, sorted by date created.  Each line item will include a 
Product Status bar you can cycle through by clicking the arrow icon, as well as a 
pointer icon indicating the original Order.  If Product is available, you can click this 
pointer icon and then reserve Product on the Order.  When the Requests tab screen is 
refreshed, you will notice that Order has now dropped off the list of Requests for that 
Product.  
 
In the Actions tab, Product requests are sorted by default Supplier.  When your 
Purchaser goes through these requests, they can see what Products are in stock, and 
may choose to reserve them for those orders, or else create a new Purchase Order to 
bring those Products in.   
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To generate a PO, you can select individual Products, and click Generate PO, or you 
can select several Products (usually on the basis of the same Supplier, or simply 
several requests for the same Product) by using the Command key.  Then, click 
Generate PO, and an unsaved Purchase Order will be created.  To order a batch of 
Requests according to default Supplier, go to the Actions tab, and click Generate PO. 
Confirm your information, and then click Save – an ID number will be assigned. This is 
the PO number you can use with your Supplier. The Purchase Order is now Processed. 
You will notice an arrow icon at the far left of each Product – clicking it will reveal the 
various Orders for which this PO is ordering Product, as well as their corresponding 
Quotes (if applicable), and the Customers for each.  
 

 
 
Note: If you delete an item from an unsaved PO, you will be asked if you want to cancel 
the original request, or re-submit it.   
 
 
Tracking 
 
To ensure that the Users are regularly informed of the status of their Orders and 
Requests, they should be sure to activate the various “My Orders” and “My POs” which 
apply to them in the Tracker Setup, accessible in the Tracker tab of the main Browser. 
This way, they will immediately be aware of Products ordered, received, and reserved 
for them, and can act accordingly. 
 
In particular, the “My Orders with Received Backorders to Reserve” and “My Orders 
with Reserved Backorders to Invoice” are very useful and should appear in each sales 
representative’s Tracker.  To install a Tracker to the list that appears in the Tracker tab 
of the main Browser, simply drag and drop it from the left column to the right.  For 
example,  installing the “My Orders with Received Backorders to Reserve” will cause 
that User’s Orders to appear in their Tracker when Product is received that should be 
reserved.  Clicking the Alerted checkbox when this installed Tracker is selected will 
result in the Tracker appearing red.   
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At that point, the User can click the View Order icon on the line item to go to that Order 
and reserve the eligible Product.  Once done, and the Order is saved, the Order will 
drop off the Tracker once the screen is refreshed.  
 
In fact, Tracker may be used to configure a unique set of updates which allow each 
User to be kept aware of all sales documents, SRO’s, and other data that are 
highlighted as an alert and which change regularly.  Each Tracker item may be 
configured to set off an alarm when certain conditions are met, such as a Quote being 
created within the last 4 hours, which would be useful for a Manager.  (see chapter on 
Tracker) 
 
 
Receiving  
 
Once the PO is processed, it is ready to have the Product marked as Received when it 
arrives from the Supplier.  To receive Product, go to the original PO and enter what you 
have received of the total order.  If a Product is serialized, it is necessary to click the 
Product line to scan or enter the serial number of the Product.  If you do not receive the 
total quantity of a Product that was initially ordered, just enter the amount you did 
receive.  Click Save.   
 

 
 
If the Product has a UPC code entered in its profile, a red U will appear next to it. If a 
UPC code is required, a green U will appear. Click the U and scan the UPC code – the 
profile will be updated.  
 



GETTING STARTED 

  14 

If all the Product is received for a Purchase Order, its status will be set to Partially 
Received.  If you receive more Product from the Supplier on a particular Purchase 
Order, go to the original Purchase Order and go to the Receiving tab.  In the Qty Rcvd 
column, ADD the quantity you received that day to the quantity that had previously 
been received.  For example, if you had ordered 10 x iPod Nano 2gb Black, and 2 had 
been received on Monday according to the procedure outlined above, there should be 
a quantity of 2 in the Qty Rcvd column.  Then, when 4 more arrive on Wednesday, the 
number you will enter in the Qty Rcvd column will be 6.  If the Product is serialized, you 
will have to enter the 4 serial numbers.  Click Save. Then, the Invoice button should 
become available – click it to create an unsaved Supplier Invoice, and there will be a 
quantity of 4 of that Product on the Supplier Invoice.  You may repeat this process until 
all Product is received on the PO, at which point the status will change to Received.   
 
Note: Supplier Invoices are what you generate to track payables to your Suppliers. To 
create a Supplier Invoice for a particular PO, click the Invoice button – an unsaved 
Supplier Invoice will appear. Verify the information and click Save – this saves a file that 
will be used in your export to the accounting package you use.  (See Accounting 
Imports) 
 
When you receive the invoice from your Supplier for the PO, you should manually 
change the status to Invoice.   
 
 
Reserving Product 
 

 
 
In an Order, each line item has a status bar and an action bar.  The status bar indicates 
the status of the existing stock for that product – Available, Reserved, Coming For 
Customers, Coming For Stock.  The action bar allows you to reserve, release, or cancel 
Product for that line item or the whole Order, as well as mark it as Invoiced.  If the 
status bar is green, it is an indication that Product is available for this line item, and may 
be reserved with the action bar once the Order has been saved.  The Product may then 
be marked, set aside, and await Invoicing.   
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Invoicing - Backend 
 
Invoices can be created 3 ways – from scratch, from a Quote, or from an Order.  If you 
are creating an Invoice from scratch, simply click the Invoice icon (pictured left) and 
populate the Invoice yourself.  Creating an invoice from a Quote or an Order will auto-
populate the Customer and the Products, and any serialized Products must have serial 
numbers attached to them.   
 
An Invoice is structured similarly to a Quote, and is assembled the same way, with the 
addition of a requirement for serial numbers of serialized Product.  When a Product 
does require a serial number, a yellow warning sign will appear beside its Product 
Code.  To enter the serial number, click the description once.  The cursor will appear in 
the data entry field.  Scan or enter the serial number, and it will call it up from the list of 
available serial numbers.   
 
Once the Customer and Product information is complete, you are able to Save it, 
automatically proceeding to the Payment screen.  Here, you can use the Payment 
Methods you’ve set up in the Tools menu to enter the Payments for the Invoice, 
including a combination of one or more methods.  For credit cards, you can process the 
payment internally, using VeriSign, or by using your existing standalone credit card 
terminal and entering the authorization number into LightSpeed.  For more information 
on Payments and Credits, please see the POS section of this manual.  
 
 
Invoicing – POS 
 
LightSpeed’s POS feature is a front-end module for creating Invoices that allows 
multiple users to log in and out, tracking their transactions.  It functions largely the 
same way the Invoice of LightSpeed’s back end, but with a polished interface that 
takes full advantage of OS X’s powerful graphics capabilities.  
 
The screen is divided into 3 sections – the middle one is the POS sales register, the one 
to the left is the Customer detail area, and to the right is the Product detail area.  The 
search bar located at the top of the sales register contains several icons that will give 
you access to Products, Customers, or other sales documents.  The first step is to add 
a Customer.  To select an exiting Customer, type a few letters from their name, or click 
All, and choose their name from the resulting list. If it is a new Customer, click the “+” 
icon at the bottom of the Customer detail area, enter the data, and then click Save.  If 
you do not wish to add the Customer to your database, click Walk-In and enter as 
much data as you want. 
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To scan a Product’s UPC and enter it in your Invoice, click the UPC icon and scan – if it 
exists in the Product database, it will automatically be added to your Invoice.  If it is 
serialized, click the Product line item once, and scan/enter the serial number.  It should 
appear in a list, which is the available serial numbers for that Product, but if it does not, 
you may still attach it to the Invoice for later reconciliation.   
 
Once the Invoice has all the correct Product and Customer information, you may click 
the Check Out button to save the Invoice and proceed to the Payments screen.  There, 
you will see buttons corresponding with each Method of Payment you have set up, and 
may use them in combination with one another.  Each payment must be saved.  You 
are also able to use Credits from previous Invoices using the Apply Credit button (if 
applicable) by choosing which Credit to apply, and specifying the amount to be used.   
 
To leave the POS layout, click the Exit button in the Customer detail area of main 
screen.   
 
 
Doing a Return 
 
In a Saved Invoice, there will be a Return button that can be used to create a Return 
Invoice using the Products on the original Invoice.  Once you have created this Return 
Invoice, you can remove any items you’re not returning from the Sales Register.  Any 
serialized items sold on the original Invoice must again have their serial number entered 
in the Return Invoice.  Payments on Return Invoices work the same way they do on 
standard Invoices, but with negative amounts indicating a return of the Customer’s 
money.   
 
 
Doing an SRO 
 
There are 4 steps in the processing of an average SRO. As the status of the SRO 
progresses, you are able to reflect this by a pull-down status menu at the bottom of the 
SRO screen.  
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Having completed the Customer information, you must book the equipment in, and you 
may include information such as serial numbers and original purchase date.  One of 
LightSpeed’s features allows you to access Apple’s GSX website to confirm a serial 
number’s warranty status – simply enter the serial number in the appropriate column 
and hit Enter.  If the warranty is valid, a photo of the model will appear along with that 
unit’s warranty details, which will populate in the SRO by clicking OK.   
 
Once the equipment is looked at, any parts that are required may be ordered as 
Products may be ordered from an Invoice, Quote, or Order.  When an Order is created 
from an SRO, and that Order is then turned into a PO, the PO will have a special GSX 
tab that includes the Customer’s information. When the parts come in, they will be 
received and allocated to the SRO as with a regular Order.   
 
All work performed on an SRO is logged in the Work tab, and entered as a Product.  In 
most cases, you would create a Product for each of your technicians and the Selling 
Price would be their hourly rate.  When you are ready to bill the SRO, including its labor 
and parts, you click the Invoice button and an unsaved Invoice will be created.   
 
In most cases, you will print both an SRO, which lists the parts and labor involved with 
the repair, and an Invoice, which bills for the parts and labor.   
 
 
Balancing the Till 
 
At the end of every night, you will need to reconcile the day’s transactions with 
LightSpeed.  For a summary of transactions, go to the Print User Reports option of the 
File menu, and choose End of Day.  A window will appear which allows you to choose 
the date for which to view the summary, and an option to see the totals for all stations 
or just for one particular station.  Clicking OK will give you an overview of totals for the 
day you’ve chosen. To see details, click the Print button, and the full summary of the 
day will appear, ready for printing.  This detailed summary includes the totals for each 
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method of payment, totals for Invoices and Returns, and the ID number range for saved 
Invoices.   
 
 
Jobs and Timesheets  
 
Timesheets are a way to track the time each User spend at work, and specifically the 
time they spend on specific Jobs and Tasks within each Job.  Jobs can be as short-
term as the setup of a store demo, or as long-term as the installation of an entire 
network.  To use Timesheets as a general record of time worked, each User can begin 
their daily Timesheet using the Timesheet icon in the Task Bar.  Once they choose their 
name from the drop-down menu, an inactive Timesheet will appear, and the General 
default will appear under both the Job Code and Task columns.  Click Start in the 
status column will begin the Timesheet, and clicking Stop will stop it.   
 

                     
 
Timesheets can also be used to track the completion of specific Jobs.  To create a new 
Job, click the Job icon in the Task Bar.  Name the Job using the Code field, and you 
can also provide a description of the Job.  If the Job needs to be broken down further, 
you can create Tasks using the “+” icon.  Users are then able to track their time for this 
specific Job, as well as the Tasks within that Job, when they create a new Timesheet.   
 
During the course of a day, it is possible that a User will complete one Job and begin 
another.  To do this, all they need to do is create a new entry on their Timesheet using 
the New button. Another line will appear as the first entry continues to count time.  
Clicking Start terminates the first entry and begins the new one simultaneously.   
 
If the User needs to run 2 Timesheets concurrently, they must click the Timesheet icon 
a second time, rather than simply using the New button within an existing Timesheet.   
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Taking Inventory 
 
There are currently 3 ways of adding your existing inventory into LightSpeed.  First, by 
doing individual Inventory Adjustments for each Product.  This would be the most time-
consuming method but allows you to enter specific notes for each Product for later 
reference.   
 
Second, you can import the information using the LightSpeed Import Tools.  Choose 
Import Products and match fields by dragging the field names in the right column to 
correspond with the data in your tab-delimited file.  While this method is faster, be 
advised that you will still have to go to each serialized Product, specify it as a serialized 
Product with the Serial Numbers checkbox, and enter the serial numbers.  To do this, 
click Adjust, and then New, and you must add as many serial numbers as is reflected in 
your Quantity.  
 
The last method is probably the easiest, and most reliable.  First, divide your store into 
sections, and create a new PO for each.  By ‘receiving’ each section into your Inventory 
using a PO, you then have an easily accessible record of your Inventory count, the 
location of each Product, and a simple way of recording the serialized Products.   
 


